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Inspiration to Develop KYTC's DDSA

Implementation Plan

» Past and on-going DDSA efforts
within KYTC

» In 2012, KY's HSIP began
developing state-specific Safety
Performance Functions (SPFs)

Q Observed Crashes

> .AEXPECtEd Crashes Safety Performance

» Applied Empirical Bayes to Function (SPF)
calculate Excess Expected

Crashes (EECs)

» Annual Network Screening to
identify possible safety projects

Excess Expected Crashes
(EEC)

' Predicted Crashes

Number of Crashes in 5 years

AADT



Inspiration to Develop KYTC's DDSA

Implementation Plan

» In 2016, the Division of Planning began developing the Strategic Highway Investment
Formula for Tomorrow (SHIFT)

» SHIFT uses data for 5 key attributes to prioritize projects for inclusion into KY's Highway Plan:

A p~< N of $

Safety Asset Congestion  Economic Benefit/
Management Growth Cost

» EEC values are part of the scoring for the Safety attribute and
Crash Modification Factors (CMFs) are part of the scoring for the Benefit/Cost attribute



Inspiration to Develop KYTC's DDSA

Implementation Plan

» October 2018, NCHRP publishes the Scan Team Report for:

» NCHRP 20-68A, Scan 16-01 — Leading Practices in the Use of the Highway Safety Manual for
Planning, Design, and Operations

» NCHRP 20-68A, Scan 16-01 was the keystone KYTC needed
» How DOTs are implementing the HSM across their agencies

» Processes, job aids/tools, and workforce training related to implementation of the HSM
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Developing KYTC's DDSA

Implementation Plan

» Identify safety champions to recruit from all Divisions
» Planning
Highway Design
Project Delivery & Preservation (aka Construction & Maintenance)
Traffic Operations
Others:

» Researchers at the University of Kentucky

vV v v Vv

» Key staff within our District offices

» A few safety analysis “experts” from the consulting community



Developing KYTC's DDSA

Implementation Plan

» Created “sub-committees” to focus on increased DDSA implementation in key areaqs:
» DDSA in Planning

DDSA in Highway Design

DDSA in Project Development & Delivery (aka Construction & Maintenance)

DDSA in Traffic Operations

DDSA Safety Analysis Tools & Training

KYTC DDSA webpage

vV v v Vv v



Original Outline of KYTC's DDSA

Implementation Plan

» Safety Data, Safety Predictions, and Safety Performance Measures
» Incorporating DDSA in Project Development
» DDSA in Planning
» DDSA in Highway Design
» Incorporating DDSA in Project Delivery & Preservation
» DDSA in Traffic Operations
» DDSA in Construction
» DDSA in Maintenance
» DDSA Tools and Resources
» DDSA Training
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Implementation Plan

Crash and Roadway Data
Safety Performance

DDSA Tools and Resources

vV v v Vv

Implementing DDSA Methods at the Network-Level
» How various KYTC areas could utilize network screening
» Implementing DDSA Methods atf the Project-Level
» How various KYTC areas could utilize project-specific safety prediction
» DDSA Training



Kentucky Transportation
Q Cabinet’s (KYTC's)
& Inspiration

QOutline

Developing and Organizing
KYTC's DDSA
mplementation Plan

Highlight 2 of KYTC’s DDSA

Tools




Crash Data Analysis Tool (CDAT)

» CDAT provides users with a searchable record of KY's:
» Crash Data
» Traffic Volumes
» Roadway Attributes

» CDAT can currently be used to:

» Obtain current Excess Expected Crash (EEC) values for predetermined
roadway segments and all intersections across the network

» Calculate EEC values for user-specified roadway segments



Crash Data Analysis Tool (CDAT)

» CDAT can currently be used to:

» Compare site specific crash type %s with crash type %s of all similar sites

» Example 1: Segment A has 65% crashes occurring on Wet Pavement vs.
the Statewide avg of 20% of crashes occurring on Wet Pavement

» Example 2: Segment A has 50% of crashes occurring at Nighttime vs.
the Statewide avg of 25% crashes occurring at Nighttime

» CDAT features being developed:

» Predicting safety performance for relatively simple proposed projects

» Goal for CDAT s to be a one-stop shop for:

» Safety-related data and network screening results (aka EEC values)

» Project-specific safety diagnosis and safety performance predictions



KYTC's CME SECliGale

» Web-based search tool
» Users can select from up to 18 different attributes to narrow down the list of applicable CMFs:
» Crash Type
» Crash Severity
» Area Type (Rural, Urban, or Suburban)
» Number of Lanes
» Traffic Control Type
» CMF list updates on the fly as attributes are selected

» The CMFID in the list is a link to the CMF Details page on the CMF Clearinghouse



Primary Deciders

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

Step 7

Step 8

Step 9

Countermeasure

6 Rumble Strips_CMF

Countermeasure Group

Edgeline rumbles

a4

a4

Countermeasure Sub-..

All
Crash Type

All

Severity

all

Roadway Type

All

Area Type
Rural
Star
Multiple selections

Std Err

All

'

Kentucky Crash Modification Factor Recommendation List

State

All e
Int Related
All v

Avg ADT (non-int)

All ~
Major Road avg. ADT (..
All av
Minor Road avg. ADT (...
All AV

No of Lanes

2 LY

Inter. Geometry

All v

Traffic Control Type

All ~

Roadway Division Type

Undivided Y

Total Number of CMFs Meet Requirements

11

Results

CMF Star State Comments

0.79 4-Stars OH The CMF includes the effects of a stat
horizontal curve warning sign upgrade

0.79 4-Stars OH The CMF includes the effects of a stat
horizontal curve warning sign upgrade

0.78 4-Stars OH The CMF includes the effects of a stat
horizontal curve warning sign upgrade

0.75 4_Stars OH The CMF includes the effects of a stat
horizontal curve warning sign upgrade

0.71 4-Stars OH The CMF includes the effects of a stat
horizontal curve warning sign upgrade

067 5-Stars MN MO PA

0.61 4-Stars MN MO PA

0.75 4_Stars KY

0.64 4_Stars KY

074 4-Stars KY

063 4-Stars KY




(MF [ CRF DETAILS

CMF1D: 9833

INSTALLEDGELINE RUMBLE STRIPS ATHORIZONTAL CURVE

DESCRIPTION: INSTALL EDGELINE RUMBLE STRIPS ATHORIZONTAL CURVE
PRIOR CONDITION: NO PRIOR CONDITION(S/
CATEGORY: ROADWAY

STUDY: SAFETY EVALUATION OF EDGE-LINE RUMBLE STRIPES ON RURAL TWO-LANE HORIZONTAL CURVES, HIMES ET AL., 2017

Star Quality Rating: 0w w0 [VIEW SCORE DETAILS]

Rating Points Total: 115

Crash Maodification Factor (CMF)

Value: 0.63
Adjusted Standard Error:

Unadjusted Standard Error: Q.14



Michael Vaughn, PE
Highway Safety Improvement Program

Division of Traffic Operations
Kentucky Transportation Cabinet

Mike.Vaughn@ky.gov
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More Informed Better Targeted Fewer Fatalities &
Decision Making Investments Serious Injuries


Presenter Notes
Presentation Notes
Data Driven Safety Analysis is the application of the latest software tools and analysis methods for analyzing crash and roadway data.

The tools quantify the expected safety impact of each decision in the project development process so we can make more informed decisions.

This lets agencies target and optimize investments.

And the goal is fewer serious and fatal crashes.


Fatalities

2016 2017 2018 2019 2020 2021


Presenter Notes
Presentation Notes
Why is a Data Driven Safety Analysis approach needed?

Like many other states, fatalities in crashes on Ohio’s roadways have been trending in the wrong direction and have steadily increased in the last few years.


Serious Injuries

2016 2017 2018 2019 2020 2021


Presenter Notes
Presentation Notes
Serious injuries had been trending down, but they saw a significant increase in 2021.

DDSA helps focus agencies resources on priority locations to make as significant of safety improvements as possible to help turn these trends around.




Application

DDSA applies to all ODOT let

projects except:

* Maintenance projects —
guardrail, mowing, striping,
signing, RPM’s, etc.

* Minor pavement surface
treatments

* Spot repairs

* Slot Paving



Presenter Notes
Presentation Notes
At Ohio DOT, DDSA is applicable to all ODOT let projects except whose primary purpose is maintenance related,

Like guardrail, mowing, striping, signing, 

Or has minor pavement surface treatments like crack sealing, chip sealing, micro surfacing

As well as projects like spot repairs and slot paving


Minimum Assessment

Obtain applicable studies Determine if location is on
for project area ODOT SIP Map

Determine ranking on
ODOT or local safety
priority list or within a
Local Road Safety Plan

Analyze
Historical/Observed Crash
Data



Presenter Notes
Presentation Notes
Regardless of the complexity of the project and even if safety is not a component of the Purpose and Need Statement, 
Four steps must be completed as part of the initial DDSA process



Obtain Applicable Studies

Ohio Department of Transportation, District 3

2021 Safety Study

WAY SR 57 SLM 10.32 SR 604

2020 District 3 Unsignalized Intersection List #36

By: |ared Feller, P.E. Date: April 2021

* Feasibility Studies
 Corridor Studies : $.1
* Traffic Impact Studies
e Safety Studies



Presenter Notes
Presentation Notes
The first step in the process is to obtain and review applicable studies that have been conducted for the study location
Such as Feasibility, Corridor, Traffic Impact or Safety Studies
These studies may have identified improvements that will mitigate the crash concerns at the study location 
or may have identified potential countermeasures that could be incorporated into the current project. 


Minimum Assessment

Obtain applicable studies Determine if location is on
for project area ODOT SIP Map

Determine ranking on
ODOT or local safety
priority list or within a
Local Road Safety Plan

Analyze
Historical/Observed Crash
Data



Presenter Notes
Presentation Notes
The next step is to determine if the project location is on ODOT’s Safety Integrated Project or SIP map.


Safety Integrated Project (SIP) Maps
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Presenter Notes
Presentation Notes
Each year, ODOT prioritizes locations for safety study or review using AASHTOWare’s Safety Analyst. 

The software flags spot locations and road segments that have higher than-predicted crash frequencies (including injury and fatality frequencies) based on HSM methodologies. 

The results are illustrated on SIP Maps for each county in Ohio, for both the local and the state system. 

Segments or spot locations which had a higher-than-predicted crash frequency when compared to similar roadway types are identified on the map in red or blue. 

The red locations are the highest priority with the most potential for safety improvement.

Blue indicates that a crash problem exists, but lower-cost countermeasures should be explored. 


Determine Ranking

Obtain applicable studies
for project area

Analyze
Historical/Observed Crash
Data

Determine if location is on
ODOT SIP Map

Determine ranking on
ODOT or local safety
priority list or within a
Local Road Safety Plan



Presenter Notes
Presentation Notes
The next step is to determine the project locations ranking on ODOT’s or Local safety priority list or if it’s listed within a Local Road Safety Plan


Determine Ranking

Rural

* [Intersection

* Non-Freeway
* Freeway

Urban

* [ntersection

* Non-Freeway
* Freeway

Suburban
e |ntersection
* Non-Freeway
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1 6|FRA MR-4207 Intersection [Int/Urb; 4-leg signalized N N 53.51 2.37 25.18 22.81
2 6/|FRA MR-4231 Intersection |Int/Urb; 4-leg signalized N N 32.79 4.83 22.44 17.61
3 6/FRA SR-317 Intersection |Int/Urb; 4-leg signalized N N 27.12 3.3 21.21 17.91
4 6/|FRA CR-17 Intersection |Int/Urb; 4-leg signalized - Div Multilane N N 22.98 5.25 20.07 14.82
5 6|FRA MR-4231 Intersection |Int/Urb; 4-leg signalized - Div Multilane N N 27.68 5.69 20.05 14.36
6 6|FRA CR-75 Intersection |Int/Urb; 4-leg signalized N N 20.73 2.94 17.93 14.99
7 7|MOT CR-230 Intersection |Int/Urb; 4-leg signalized - Div Multilane N N 22.74 3.29 16.83 13.54
8 6[FRA MR-4231 Intersection [Int/Urb; 4-leg signalized N N 29.46 3.01 16.57 13.56
9 7|MOT MR-4972 Intersection [Int/Urb; 4-leg signalized N N 36.07 2.1 16.36 14.26
10 6[FRA MR-4231 Intersection [Int/Urb; 3-leg signalized - Div Multilane N N 20.84 5.55 14.81 9.26
11 6|FRA SR-16 Intersection [Int/Urb; 4-leg signalized N N 19.35 2.97 14.75 11.78
12 6[FRA MR-4207 Intersection |Int/Urb; 4-leg signalized N N 31.75 1.86 14.65 12.79
13 6|FRA MR-4205 Intersection |Int/Urb; 4-leg signalized N N 24.86) 2.74 14.01 11.27
14 6|FRA MR-4205 Intersection [Int/Urb; 4-leg signalized N N 24.36| 2.76 13.73 10.97
15 6|FRA US-62 Intersection |Int/Urb; 4-leg signalized N N 20.15 2.06 13.69 11.63
16 2|LUC SR-2 Intersection [Int/Urb; 4-leg signalized N N 15.68| 1.93 12.89 10.96|



Presenter Notes
Presentation Notes
ODOT maintains and updates priority lists for the state roadway system. 
Locations are grouped by urban and rural intersections, freeway segments, and non-freeway segments. 
The ODOT ranking is based on the calculated expected fatal and all injury crashes. 


Analyze Historical/Observed Crash Data

Obtain applicable studies Determine if location is on
for project area ODOT SIP Map

Determine ranking on
ODOT or local safety
priority list or within a
Local Road Safety Plan

Analyze
Historical/Observed Crash
Data



Presenter Notes
Presentation Notes
The final step of the minimum assessment is to analyze observed crash data.


= Analyze Historical/Observed Crash Data

-



Presenter Notes
Presentation Notes
Using ODOT’s GIS Crash Analysis Tool, users can identify and download all crashes in the last 3 years, at a minimum, within the project area.


Analyze Historical/Observed Crash Data
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Crash Report
Crash Report
Crash Report
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Crash Report
Crash Report
Crash Report
Crash Report
Crash Report
Crash Report
Crash Report
Crash Report
Crash Report
Crash Report
Crash Report
Crash Report
Crash Report
Crash Report
Crash Report
Crash Report
Crash Report
Crash Report
Crash Report
Crash Report
Crash Report

Document
20186016106
20186056284
20186085013
20186120746
20186121736
20186037474
20186081915
20186112426
20186147165
20186147499
20186140934
20186140936
20186195521
20186196876
20186196900
20186047942
20186126624
20186163800
20186214241
20186216452
20186105184
20186173473
20186174692
20186197959
20193000292
20193000301
20193001992
20193002515
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2018
2018
2018
2018
2018
2018
2018
2018
2018
2018
2018
2018
2018
2018
2018
2018
2018
2018
2018
2018
2018
2018
2018
2018
2019
2019
2019
2019

20193029657 2019

20193029824
20186058780
20186058911
20186097875
20186169095
20193048250
20186203733
20186205415
20193009452
20193067419
20193068569
20186069901

2019
2018
2018
2018
2018
2019
2018
2018
2019
2019
2019
2018

Local Report Num ~ |User Defin| ~
180054228
180269957
180425118
180640079
180643628
180182545
180418355
180590281
180784040
180788907
180753951
180754684
180997230
180995704
180993502
180212943
180678706
180842761
181073922
181056269
180544107
180912181
180893221
180999163
190009116
190009502
190012191
190025960
190162892
190161920
180288372
180259703
180488678
180893172
P190252199
181028193
181024325
190055279
190253318
190334029
180353157

Severity | v
) PDO/Na Inju Rear End
) PDO/No Inju Rear End
) PDO/Na Inju Rear End
) Injury Possit Angle

) PDO/Na Inju Rear End
) PDO/No InjuRear End
) PDO/Na Inju Sideswipe
) Minar Injury Head On
) PDO/Na Inju Rear End
} Injury Possit Left Turn

) PDO/Na Inju Sideswipe
) PDO/Ma Inju Rear End
) Minor Injury Pedestrian
) PDO/No InjuRear End
) PDO/Na Inju Right Turn
) PDO/MNa Inju Sideswipe
) PDO/Na Inju Rear End
) PDO/No InjuRear End
) PDO/Na InjuLeft Tumn

) Injury Possil Pedestrian
) PDO/No Inju Rear End
} PDO/Mao Inju Sideswipe
) PDO/Nao Inju Rear End
) PDO/Na Inju Rear End
) Injury Possilt Right Turn
} Injury Possit Rear End
) PDO/Ma InjuLeft Tumn

) PDO/Na Inju Sideswipe
) PDO/Nao Inju Sideswipe
) PDO/Na Inju Rear End
) PDO/Na Inju Sideswipe
) PDO/Na Inju Rear End
} PDO/MNao Inju Sideswipe
) PDO/Na Inju Sideswipe
) PDO/Ma Inju Sideswipe
) PDO/Na Inju Sideswipe
) PDO/No Inju Backing

) PDO/Na Inju Rear End
) Serious Injur Pedestrian
) PDO/Ma Inju Angle

) Injury Possil Rear End

Crash Type ~

- Passing

- Passing

- Passing

- Passing

- Passing
- Passing

- Passing

- Passing
- Passing
- Passing
- Passing

ODOT Distr v | County | v
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FRA
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FRA
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FRA
FRA
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FRA
FRA
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FRA
FRA
FRA
FRA
FRA
FRA
FRA
FRA
FRA
FRA
FRA
FRA
FRA
FRA
FRA
FRA
FRA
FRA
FRA
FRA
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QDOT Crash Location| ~

Mot An Intersection
Mot An Intersection
Four-Way Intersection
Mot An Intersection
Four-Way Intersection
Mot An Intersection
Mot An Intersection
Four-Way Intersection
Four-Way Intersection
Four-Way Intersection
Four-Way Intersection
Four-Way Intersection
Four-Way Intersection
Mot An Intersection
Four-Way Intersection
Four-Way Intersection
Four-Way Intersection
Four-Way Intersection
Four-Way Intersection
Four-Way Intersection
Four-Way Intersection
Four-Way Intersection
Mot An Intersection
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Mot An Intersection
Mot An Intersection
Mot An Intersection
Mot An Intersection
Mot An Intersection
Mot An Intersection
Four-Way Intersection
Four-Way Intersection
Mot An Intersection
Mot An Intersection
Four-Way Intersection
Mot An Intersection
Shared-Use Paths Or Trails
Mot An Intersection
Mot An Intersection
Mot An Intersection
Mot An Intersection

NLFID
MFRAMRO4254*C
MFRAMRO4254*C
MFRAMRO4254C
MFRAMRO4254™C
MFRAMRO4254*C
MFRAMRO4254C
MFRAMRO04254*C
MFRAMRO4254™C
MFRAMRO4207C
MFRAMRO4207C
MFRAMRO4254™C
MFRAMRO4207C
MFRAMRO4207C
MFRAMRO4254C
MFRAMRO4254™C
MFRAMRO4254™C
MFRAMRO4254*C
MFRAMRO4254C
MFRAMRO4207C
MFRAMRO4207+C
MFRAMRO4254*C
MFRAMRO04254™C
MFRAMRO4254™C
MFRAMRO4207+C
MFRAMRO4254*C
MFRAMRO4207C
MFRAMRO4254™C
MFRAMRO4254*C
MFRAMRO4207C
MFRAMRO4254C
MFRAMRO4254™C
MFRAMRO4207C
MFRAMRO4207C
MFRAMRO04254*C
MFRAMRO4254™C
MFRAMRO4207C
MFRAMRO4207C
MFRAMRO04254*C
MFRAMRO4254™C
MFRAMRO4254*C
MFRAMRO4254C

1.761
1.74

1.774
1.75

1.75

1.75

1.774
1.75

1.242
1.247
1.74

1.245
1.252
1.774
1.774
1.774
1.761
1.75%
1.247
1.248
1.774
1.76

1.75%
1.247
1.722
1.239
1.796
1.783
1.211
1.755
1.75

1.253
1.224
1.759
1.75%
1.247
1.21

1.734
1.75%
1.76

1.704

- County True L = State True L ~

1.761
1.74

1.774
1.75

1.75

1.75

1.774
1.75

1.242
1.247
1.74

1.245
1.252
1.774
1.774
1.774
1.761
1.75%
1.247
1.248
1.774
1.76

1.75%
1.247
1.722
1.239
1.796
1.783
1.211
1.755
1.75

1.253
1.224
1.759
1.759
1.247
1.21

1.734
1.759
1.76

1.704

On Road | ~

MR4254
MR4254
MR4254
MR4254
MR4254
MR4254
MR4254
MR4254
MR4207
MR4207
MR4254
MR4207
MR4207
MR4254
MR4254
MR4254
MR4254
MR4254
MR4207
MR4207
MR4254
MR4254
MR4254
MR4207
MR4254
MR4207
MR4254
MR4254
MR4207
MR4254
MR4254
MR4207
MR4207
MR4254
MR4254
MR4207
MR4207
MR4254
MR4254
MR4254
MR4254

At Road | ~ |ODOT Latitu ¥ ODOT Longitu
-32.915597
-82.915409
-32.915645
-32.915503
-32.915503
-82.915503
-82.915645
-32.915503
-82.915681
-82.915593
-§2.915409
-32.915628
-82.915501
-82.915645
-§2.915645
-32.915645
-82.915596
-82.915586
-§2.915593
-32.915574
-82.915645
-32.915593
-32.915586
-32.915593
-82 915267
82915741
-32.915663
-32.91568

-82.916265
-32.915545
-32.915503
-32.915482
-82.916017
-32.915586
-32.915586
-32.915591
-82.916286
-82.915355
-32.915586
-82.91559

-82.91528

E LIVINGSTON 39 946884
S LIVINGSTON 39 946603
S JAMES RD 39947064
SR3 39946734
E LIVINGSTON 39.946734
E LIVINGSTON 39 946734
IR1 39947064
E LIVINGSTON 39.946734
SJAMES RD 39946872
S JAMES RD 39 946866
E LIVINGSTON 39.946603
SJAMES RD 39.946869
SJAMES RD 39946861
E LIVINGSTON 39.947064
E LIVINGSTON 39.947064
E LIVINGSTON 39.947064
E LIVINGSTON 39 94688
E LIVINGSTON 39 946856
S JAMES RD 39.946866
S JAMES RD  39.946865
E LIVINGSTON 39 947064
E LIVINGSTON 39 946866
E LIVINGSTON 39.946856
S JAMES RD 39.946866
SJames RD 39946293
SJames RD 39 946875
E LIVINGSTON 39.94739
E LIVINGSTON 39.947195
SJames RD 39946907
SJames RD  39.9468

E LIVINGSTON 39.946734
SJAMES RD 3994686
BRICE RD 39 946892
E LIVINGSTON 39 946856
E LIVINGSTON 39.946856
SJAMES RD 39946866
WALGREENS 39 946908
E LLIVINGSTO! 39 946516
E LIVINGSTON 39.946856
LIVINGSTOMN A’ 39 946863
DOVER RD 39946081



Presenter Notes
Presentation Notes
These crashes are then loaded into our Crash Analysis Module excel based tool that takes raw crash data and separates it into different attribute tables to help identify crash patterns.



Analyze Historical/Observed Crash Data

Crashes by Crash Type
Total (%) Fatal & All Injury (%)

Crash Type Site Average Statewide Average Site Average Statewide Average
Unknown 0.70% 0.23% 0.70% 0.15%
Head On 4.26% 1.63% 4.26% 3.16%
Rear End 36.17% 39.17% 36.17% 40.14%
Backing 1.42% 2.59% 1.42% 0.74%
Sideswipe - Meeting 0.00% 0.87% 0.00% 0.82%

ideswipe - Passin 23.40% 13.23% 23.40% 6.16%

ngle 13.48% 8.78% 13.48% 11.31%
Parked Vehicle 0.00% 2.49% 0.00% 1.33%
Pedestrian 4.96% 1.29% 4.96% 4.16%
Animal 0.00% 2.50% 0.00% 0.50%
Train 0.00% 0.01% 0.00% 0.02%
Pedalcycles 0.00% 0.90% 0.00% 2.64%
Other Non-Vehicle 0.00% 0.00% 0.00% 0.00%
Fixed Object 1.42% 6.36% 1.42% 7.63%
Other Object 0.00% 0.23% 0.00% 0.10%
Falling From Or In Vehicle 0.00% 0.00% 0.00% 0.00%
Overturning 0.00% 0.17% 0.00% 0.45%
Other Non-Collision 0.00% 0.36% 0.00% 0.35%
Left Turn 11.35% 15.12% 11.35% 17.74%
Right Turn 2.84% 4.07% 2.84% 2.60%



Presenter Notes
Presentation Notes
Crash summaries, graphs, and charts can be created that assist with diagnosing and defining safety issues that can be used to develop countermeasures. 

This procedure speeds up the process in identifying mitigation strategies.

For example, this chart is showing proportions of crashes by the type of our site compared to the state average for similar site types.

We can quickly see that rear-ends account for the highest % of crashes, and that sideswipes, angle, and pedestrian related crashes are overrepresented at this site compared to similar sites.



Analyze Historical/Observed Crash Data

OHIO SHSP
EMPHASIS AREAS (Total Crashes)

2021 2021 2020 2020 2019 2019 2018 2018

Target Group Crashes y&:ﬁ:ﬂ:' Crashes T&:ﬁ;ﬂ:' Crashes T;:ﬁ;f:' Crashes y&:;:::'

Total Crashes by Year 19 36 49 37
Roadway Departure 1 5% 2 6% 0 0% 0 0%
Intersection 16 84% 31 86% 38 78% 27 73%
Railroad Crossing 0 0% 0 0% 0 0% 0 0%
Alcohol Related Involvement 1 5% 0 0% 1 2% 1 3%
Restraints Not Used Driver/Occupants 2 11% 1 3% 1 2% 3 8%
Speed Related Involvement 3 16% 5 14% 2 4% 2 5%
Young Driver Involvement (15-25) 6 32% 13 36% 16 33% 9 24%
Older Driver Involvement (65+) 3 16% 6 17% 8 16% 7 19%
Distracted Drivers 0 0% 1 3% 0 0% 3 8%
Motorcycle Driver/Passenger 0 0% 1 3% 0 0% 0 0%
Pedestrian Involvement 0 0% 2 6% 3 6% 2 5%
Bicycle Involvement 0 0% 0 0% 0 0% 0 0%
Work Zone Related 3 16% 5 14% 4 8% 0 0%
Drug Related Involvement 0 0% 1 3% 0 0% 1 3%
Marijuana Involvement 0 0% 0 0% 0 0% 0 0%
Rear End 7 37% 13 36% 14 29% 17 46%



Presenter Notes
Presentation Notes
We can also see how crashes are represented across our SHSP emphasis areas to help identify any trends.

There’s a lot of other useful charts and graphs that break down crashes by Unit Type, Contributing Circumstances, Road Condition, Time, Day, Month, and many others.



Minimum Assessment

Obtain applicable studies Determine if location is on
for project area ODOT SIP Map

Determine ranking on
ODOT or local safety
priority list or within a
Local Road Safety Plan

Analyze
Historical/Observed Crash
Data



Presenter Notes
Presentation Notes
Once the minimum assessment is completed, the complexity, purpose & need and funding type will determine which steps are taken next.


Safety Assessment Process

Safety Assessment Process

I

Non-Complex | | Complex Project Complex Project

Project Assessment Assessment with
Assessment without Safety in Alternative
(No Alternative| | the Purpose & Analysis and

Analysis) Need Statement | |Safety Component



Presenter Notes
Presentation Notes
The Safety Assessment process is broken out into three paths;

Non-Complex Project Assessments that don’t require an Alternative Analysis

Complex Project Assessments that don’t have “Safety” in the Purpose & Need Statement

Complex Project Assessments with Alternative Analysis and Safety Component




Safety Assessment Process

For projects without “Safety” considerations in
the purpose and need.

For profects with "Safety” considerations in the
purpose ond need.

Obtain applicable
studies for project
area (including safety

For projects without the explicit reference to
“Safety” in the purpose and need.

Obtain applicable
studies for project
area (including :sal'e._,

AND / OR
AND
AND

For projects with intended safety funaing requests.

For projects without intended safety funding

requests. For projects not requesting safety funding.

Determine if location
is on ODOT SIP Map

Deterrmine if location

Summarize Safaty T SIP Map

in project file

Deterrmine ranking on
QDOT ar local safety

Determine ranking on
QDaT o
prionty list or
Local Road Saf
(LRSP)

Local Road Safety Plan
(LRSP}

Is location on
Ho— state or local priority
list?

Are crash
percentages above
statewide averages?

Analyze Historical /
Observed Crash Data

Submit crash history
to DSRT (for state
projects) or local

agency/MPO (for lacal
projects) for RSA
caonsideration

Yes

Estimate the chan
e

.
[with CMFs) for the
major project
:-:mpl::n-sﬂt for each

alternative

Can safety
countermeasures bE
ncluded in the curren
project?

Document the
estimated crash
reduction related to
the countermeasure

Yes

Use results in

Estimate the change
in predicted crashes
{with CMFs) for the
major praject
components for each

alal, ﬁiﬂ;ﬂ il=
of-Way, Oper;
Geometrics, and Cost

Consider Pursuing

separate praject to
address crash pattern

prefarrad altarmatiee

It £ B
bl that fulfills the



Presenter Notes
Presentation Notes
We have 3 flowcharts, one for each process


Non-Complex Projects

e,

‘Source: Ohio'DO:


Presenter Notes
Presentation Notes
The Non-Complex project assessment should be completed for projects that do not require an alternatives analysis as part of the Project Development Process.

This type of project often includes maintenance and operations projects such as resurfacing, culvert replacements, in-kind bridge replacements, signal improvements, etc. 

The primary purpose of assessing safety on non-complex projects is to identify any cost-effective safety improvements that should be included in the project to mitigate a current safety problem, and/or assist with the development of design exception justifications to allow for a more cost-effective design. 



Non-Complex Projects

Are crash
percentages above
statewide averages?

Summarize Safety

Is location on
state or local priority
list?

‘féas

Submit crash history
to DSRT (for state
projects) or local

agency/MPO (for local
projects) for RSA
consideration



Presenter Notes
Presentation Notes
From the minimum assessment, crash percentages are compared to the statewide average
And whether or not the project location is on a state or local priority list can be determined.

In cases where crashes are lower than the statewide average at similar site types there are two possible paths:
If the project location is not on a priority list: The Safety Evaluation is summarized and added to the project file.
If the project is on a priority list the safety evaluation is submitted to the District Safety Review Team or local agency to determine if a Road Safety Audit should be conducted.


Non-Complex Projects

Can safety
countermeasures be
included in the curren
project?

Document the
estimated crash
reduction related to
the countermeasure

Consider Pursuing
separate project to
address crash pattern



Presenter Notes
Presentation Notes
In cases where crashes are higher than the statewide average at similar site types
Determining whether or not safety countermeasures can be included in the project is evaluated.

If they can – the estimated crash reduction related to the countermeasure is calculated and documented
If none can be included – a separate project should be considered to address the crash problem should be considered.


Non-Complex Projects

Project Safety Analysis Checklist

Non-Complex Projects
General Information

Project Name PID
Project Description ODOT District
) P ODOT Project Manager
Project Limits Date Performed
Priority Lists
ODOT SIP Map
List Ranking Location
Priority List Rankings
Historical Crash Data
Crash Analysis Years Total Crash Freguency
Fatal Crash Frequency Injury Crash Frequency

Historical Crash Analysis

DDSA Process

Are crash frequencies above statewide
averages?

Data forwarded for RSA
consideration?

Can safety countermeasures be
included in the current project?



Presenter Notes
Presentation Notes
Each of the 3 paths has its own individual safety analysis checklist form that is filled out at the completion of the safety analysis.

This form summarizes the basic project info, priority list rankings, historical crash stats, crash frequency averages, details of the crash analysis and the resulting decisions of if and how safety issues are being addressed.


Complex Projects (No Safety Component)



Presenter Notes
Presentation Notes
Complex projects require the evaluation of multiple alternatives. 

Typically to select a preferred alternative under the PDP, criteria such as traffic operational benefits, construction costs, right-of-way impacts, environmental impacts, etc. are quantified and compared across all alternatives. 

The HSM has improved the method for quantifying safety benefits of an alternative so that safety can also be a quantitative metric for evaluating improvement options. 

This assessment process is for complex projects that do not reference “safety” in the Purpose and Need Statement and safety funding is not being requested.


Complex Projects (No Safety Component)

Will Estimate the change TS existing
in expected crash

oy smate Ryl ceca i
major project alternatives

the existing .
conditions? components for each IgiIRREINVAN
alternative

Use results in

: conjunction with
Do not use Estimate the change Environmental, Right-

existing crash BRNIE el Ha A= ) :
g cras (with CMFs) for the ofWay, Dpetation;

data in o Geometrics, and Cost
CRENEWNTIN components for each comfponents to select
HSM analysis alternative preferred alternative

that fulfills the
purpose and need.


Presenter Notes
Presentation Notes
After completing the minimum assessment steps, 
The next step is estimating the change in number and severity of crashes for each alternative.

If any of the alternatives use an SPF that differs from the existing condition then existing crash data is not used and predicted crashes, with CMFs applied, are calculated…

Otherwise, existing crash data is factored in the HSM analyses and expected crashes, with CMF’s applied, are calculated.

The results are then used in conjunction with Environmental, Right of way, Operations, Geometrics and Cost components

To select a preferred alternative that fulfills the purpose and need.


Complex Projects (No Safety Component)

Project Safety Analysis Checklist
Complex Projects (Alternatives Analysis) with Safety Component

General Information

Project Mame

PID

Project Description

ODOT District

ODOT Project Manager

Project Limits

Date Performed

Priority Lists

ODOT SIP Map

Priority List Rankings

List

Ranking

Location

Historical Crash Data

Crash Analysis Years

Total Crash Frequency

Fatal Crash Frequency

Injury Crash Frequency

Historical Crash Analysis



Presenter Notes
Presentation Notes
Again, the safety analyses results are summarized on the analysis checklist form and added to the project folder.


Complex Projects (No Safety Component)

DDSA Process
Will any alternative use SPFs that differ
from existing conditions?
Estimate the change in Expected Crashes
ECAT FOR EXISTING CONDITIONS KA B C 0 Total

Predicted Existing Conditions
Expected Existing Conditions

PSI Existing Conditions
Expected Alternative 1

Applying for safety funding?
(If YES, attach safety funding
application) Other funding sources:

Will funding sources other than safety
be obtained?



Presenter Notes
Presentation Notes
The form for this path has additional inputs to summarize the Predicted or Expected crash calculations.


Complex Projects with Safety Component

T - ——

e -



Presenter Notes
Presentation Notes
The 3rd analysis process should be followed for complex projects with multiple alternatives 
where a safety improvement need has been identified in the Purpose and Need Statement 
and/or where safety funding is being sought for the project.



Will
any alternative use
SPFs that differ from
the existing
conditions?

Estimate the change
predicted crashes
(with CMFs) for the
major project
components for each
alternative

Complex Projects with Safety Component

Estimate the change
expected crashes (with

s oo 2 CMFs) for the major

project components
for each alternative

Does at
least one alternative
reduce crashes or
crash severity?

Add additional safety
countermeasures to
project alternatives



Presenter Notes
Presentation Notes
When Safety is a component, either in the purpose & need or if safety funding is being sought, then a few additional steps to the previous flow chart are required.

The first step is tweaking the alternatives if needed until at least one alternative reduces crashes or crash severity.







Complex Projects with Safety Component

Use results in
conjunction with

Environmental, Right-
s safety of-Way, Operation,
funding being \lae 4 Geometrics, and Cost
sought? components to select
preferred alternative
that fulfills the
purpose and need.



Presenter Notes
Presentation Notes
Once there is an alternative that reduces either crashes or severity, the next question is whether or not safety funding is being sought.

If not, then the safety analysis is complete, the forms are filled out and the results are used in conjunction with other design components to select a preferred alternative that fulfills the purpose and need.







Complex Projects with Safety Component

Prepare safety
application for
preferred alternative

Is benefit cost
ratio above 1.007?

Will other funding
. sources be obtained for
the project?


Presenter Notes
Presentation Notes
If safety funding is being sought, we next want to determine if the benefit cost ratio is above or below 1.00.

If it’s above 1, the safety analysis is complete, the analysis checklists are filled out and a safety application is filled out for the preferred alternative.





Complex Projects with Safety Component

Will other funding
sources be obtained for
the project?

Calculate benefit cost
ratio for safety
component

Prepare safety
application for
preferred alternative
for justified safety
costs (see Safety
Analysis Guidelines)
and include
explaination on other
funding sources

Is benefit cost
ratio for safety
component
above 1.007



Presenter Notes
Presentation Notes
If safety funding is the only funding source, and the B/C is less than 1 then we go back to evaluating countermeasures and calculating the change in crashes and severity.

If all countermeasures have been explored and an alternative can’t get the B/C above 1 then other funding sources should be sought out because this isnt an ideal project to allocate safety funding towards.







Complex Projects with Safety Component

Will other funding
® sources be obtained for
the project?

Calculate benefit cost
ratio for safety
component

Prepare safety
application for
preferred alternative
for justified safety
costs (see Safety
Analysis Guidelines)
and include
explaination on other
funding sources

Is benefit cost
ratio for safety
component
above 1.007



Presenter Notes
Presentation Notes
If there are other funding sources, then we will calculate the B/C ratio for just the safety component.

If the B/C ratio for the safety component is over 1, then the safety analysis is complete, the safety analysis checklists are filled out and a safety application for the preferred alternative is submitted for the justified amount of safety costs.






Complex Projects with Safety Component

Add additional safety J
§ countermeasures to
project alternatives

'

Have all
Moy countermeasures been
explored?

Seek other funding
sources



Presenter Notes
Presentation Notes
If the benefit cost ratio of the safety component is still below 1 then we go back through exploring countermeasures and rerunning the crash analyses.

If all countermeasures are explored and the safety funding component B/C is still below 1 then other funding sources should be sought to fund the project.






Complex Projects with Safety Component

Project Safety Analysis Checklist
Complex Projects (Alternatives Analysis) with Safety Component

General Information

Project Mame

PID

Project Description

ODOT District

ODOT Project Manager

Project Limits

Date Performed

Priority Lists

ODOT SIP Map

Priority List Rankings

List

Ranking

Location

Historical Crash Data

Crash Analysis Years

Total Crash Frequency

Fatal Crash Frequency

Injury Crash Frequency

Historical Crash Analysis



Presenter Notes
Presentation Notes
Again, the safety analyses results are summarized on the analysis checklist form and added to the project folder.



Complex Projects with Safety Component

DDSA Process
Will any alternative use SPFs that differ
from existing conditions?
Estimate the change in Expected Crashes
ECAT FOR EXISTING CONDITIONS KA B C 0 Total

Predicted Existing Conditions
Expected Existing Conditions

PSI Existing Conditions
Expected Alternative 1

Applying for safety funding?
(If YES, attach safety funding
application) Other funding sources:

Will funding sources other than safety
be obtained?



Presenter Notes
Presentation Notes
This is the same form as the previous path of projects that did not have a safety component.


Overview

Non-Complex Complex - No Safety Complex - Safety
e

e Minimum Assessment e Minimum Assessment * Minimum Assessment

* Apply e Estimate change in * Estimate change in
countermeasures if Predicted/Expected Predicted/Expected
needed & able Crashes Crashes (must reduce)

* Requires B/C over 1 for
project or safety
component of project
for safety funding
eligibility


Presenter Notes
Presentation Notes
In summary,

All non-maintenance projects follow one of 3 DDSA processes,

Non-Complex projects go through a minimum assessment and apply countermeasures if able and if needed

Complex projects without a safety component require a slightly more detailed crash analysis and the results are used to help select a preferred alternative

Complex projects that are requesting safety funding or have a safety improvement identified in the purpose and need must reduce crashes and/or severity and meet benefit cost requirements for the safety component at a minimum.


EVERY MOVE YOU MAKE

Brenton Bo
gard
TOWARD Ohio Department of Transportation

DEATHS Brenton.Bogard@dot.ohio.gov



Presenter Notes
Presentation Notes
Thank you!


MaineDOT Rural Two
lLane Network

Screening using Part C
of HSM



Initial Expectations

 Resultant dataset would be data driven.

* Generate Predictive Results and Expected Results using 3,5, and 10
Years of Observed Crash Data

e Publish GIS version of the results to ArcGIS Online (AGOL) and use
applications like AGOL Dashboards to review the results.

* |dentify any new data elements that might be needed.
 Create different visualizations
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Example of Final GIS

Product

SUPERELE

Hz Hz uz CURVE RURAL  VATION EXPECTED £

NUMYEA GENERAL SEGMENT/CURVE CURVE LEN  GREATES MEAS  SUPERELEDESIGN VARIANC COMBINE COSTPER  EXPECTEDIOVR EXPECTEDIOVR  CRA

HsM seg Def RS RTCODE BMP  EMP  CURVEID TVPE  (ENGTH RADIUS (ENGTH MILES TSLOPE SUPER VVAR SUPER ERURAL CMF  YEAR WORTH WORTH PER
[H5M Two Way Segment 30001X  439.887 439.507 21910 Tangent 0.02 0 1633998  0.309 5.858099 1217542 $337780  $38743.40 $24,860.90
HM Two Way Segment J0001X  439.907 440135 21908 Curve 028 652093 1193948  0.26 6.180926 2.48507 0 22 0 1322383  $69,042.86  $791916.16 4508,161.46
HSM Two Way Segment J0001X 440135 44004 21907 Curve 0005 6557335 1057.185 0.2 6180926 1795823 0.004042 22 0404177 1377902 $89853  §10,306.07 46,613.26
HSM Two Way Segment 3 0001X 4014 20335 21907 Curve 0195 6557335 1057.185 0.2 6180926 1795823 0.004042 22 0404177 134186  $6545221  STS0,73L63 $481,733.96
HSM Two Way Segment J0001X 440335 440396 21905 Tangent (.06l 0 710024 0134 6.115754 128036 S1L067.83  $126,948.29 $81,46093
HSM Two Way Segment J0001X 440395 440435 21905 Tangent (.03 0 710024 013 2703655 1103759 619,896  $220,098.15 $141,223.89
HSM Two Way Segment J0001X 440435 440472 21905 Tangent  0.037 0 710024 0138 2727801 1103759 $6,03399  $69,209.39 $14,410,69
HSM Two Way Segment J0001X 440472 440706 21904 Curve 0.34 5760579 1239514  0.35 2727801 3.643722 0 24 0 L1459 $5240678  S601,10164 $385,718.46
HSM Two Way Segment J0001X 440705 440.81 21902 Tangent  0.104 0 958611 0182 0.892723 L0Z7281  $1608214  $184,460.88 $118,365.95
HSM Two Way Segment 3 0001X 4081 44089 21902 Tangent 0.08 0 958611 0182 0.892723 L2076 $36,79666  $422,054.79 $270,826.62
HSM Two Way Segment 3 0001X 44089 440821 21902 Tangent 0031 0 958611 0182 0.83273 1023683 $5007.04  $57,430.35 $26,852.25
HSM Two Way Segment J0001X 440921 41033 21902 Tangent (.11 0 958611 0182 0.620954 1140427 1956440  $224,402.13 $143,995.69
HSM Two Way Segment J0001X 441033 ML178 21900 Curve 0145 7792233 768585 0146 0.622954 -2.48479 0.024848 0 243751 1326893 $43432.83 49817114 $319,669.41
HSM Two Way Segment J0001X 441178 441279 21899 Curve 0101 7152955 539035 0102 0.622954 -2.26835 0022684 0 2268352 135071 1985077  $227,698.24 $146,110.76
HSM Two Way Segment J0001X 441279 41357 21898 Curve 0078 2351125 408693 0077 0622954 -39413 0.085413 46 8541301 1805391 1910780 $219,167.14 $140,636.47
HSM Two Way Segment J0001X 441357 ML378 21897 Curve 0021 2077.8% 113422 0021 05295 1153759 0.036462 A8 3646241 2808873 9639731  $73.376.64 £17,084.76
HSM Two Way Segment J0001X 441378 441478 21896 Curve 01 7766281 531558  0.101 0.771609 2367438 0 0 0 1259126  $3346459 538383621 $246,302.30
HSM Two Way Segment J0001X 441478 44161 21895 Curve 0132 2196487 983585 0186 0.771509 4.289786 0.005102 4.8 0510214 1330311  $25677.54  $294,519.36 $188,588.93
HSM Two Way Segment 3 0001X 44161 441664 21895 Curve 0054 2196457 983585 0186 1771609 4.289786 0.005102 48 0510214 1341331 934576  $114,077.08 $73,201.66
HSM Two Way Segment J0001X 441664 A41806 21893 Tangent  0.142 0 67493 0128 1771609 1273013 $53,13755 460948351 $391,006.99
HSM Two Way Segment J0001X 441806 41874 21893 Tangent  0.068 0 67493 0128 1072193 1190754 481878 $284,669.45 $182,668.38
HSM Two Way Segment J0001X 440874 441887  Z18%3Tangent  (.013 0 67493 0128 0311567 1190754 $,19985  $25232.11 $16,191.09
HSM Two Way Segment J0001X 441887 44197 21891 Curve 0083 1809307 921302 0174 0311567 3.6925% 0.015075 5. L507466 1428103 $3L,097.09  $356,681.17 $228,871.9
HSM Two Way Segment 3 0001X 44197 442061 21891 Curve 0091 1809307 921302 0174 1314301 3.692534 0.015075 5. L507466 1591127 3545587  $406,677.18 $260,959.03
HSM Two Way Segment J0001X 442061 M2161 21830 Curve 01 7209.178 526926 01 1914301 -187698 (0.01877 0 1976975 165218) 3826841  $438,9%5.65 $281,658.83
HSM Two Way Segment J0001X 442061 442272 21883 Tangent (.11 0 1859997 0352 1514301 1460292 3749608 $430,077.08 $275,97.41
HSM Two Way Segment J0001X 442272 442433  2s8aTangent (.51 0 1859997 0352 0.093924 1464292 $1985189  $342,398.83 $219,712.51
HSM Two Way Segment J0001X 442423 M25 21883 Tangent  0.077 0 1859997 0352 2.734285 1680932 S16677.94  $191,294.66 $122,751.09
HSM Two Way Segment 3 0001X 425 442551 21888 Tangent 0051 0 1859997 0352 2.734285 1655285 $1152281  §132,166.07 $34,809.11
HSM Two Way Segment J0001X 442551 442594 21883 Tangent 0043 0 1859997 0352 2313108 L655285  $27489.2  $315.298.04 $202,32.32
HSM Two Way Segment J0001X 442594 442783 21888 Tangent (189 0 1859997 0352 1685477 1441951  $7156856  $820,885.74 $526,750.83
HSM Two Way Segment J0001X 442783 442.924 21888 Tangent  0.141 0 1859997 0352 3.884743 L586146  $48,30249  $554,025.75 $355,510.53
HSM Two Way Segment J0001X  442.924 442934 21888 Tangent 0.7 0 1859997 0352 3.301505 L536146  $1539230  $176,548.47 $113,288.67
HSM Two Way Segment J0001X 442984 443204 21888 Tangent 021 0 1859997 0352 195413 1310937  $55,94766  $641,715.25 $411,779.65
HSM Two Way Segment J0001X 443204 44305 21883 Tangent  (0.046 0 1859997 0352 132484 L175924  $5,28659 59504653 $60,990.02
HSM Two Way Segment 3 0001X 44325 443449 21888 Tangent 0199 0 1859997 0352 132484 L1677 $3819361  $438,077.70 $281,108.29
HSM Two Way Segment J0001X 443449 M43.635 21883 Tangent  0.186 0 1859997 0352 12032 L168477  $35,69855  $409459.56 $262,784.44
HSM Two Way Segment J0001X  AA3.635 M43.647 21888 Tangent (.01 0 1859997 0352 4741411 1285325 8245645  $28175.29 $18,079.69
HESAM Tinn \Wav Sanmant. 2.N0M1Y A2 AT AA2 Q5Q M279 Fung, N7 5312257 1121129 02125005099 72 2A55R5 N ANI5AA QAN ISAAS 1244718 &A1.722 NA 47117 948 a9 &451 N85 21




Two Way Rural Roadways

* Maine DOT State Urban
Rural

* Two Way

* Doesn’t include Interstate
or Freeway and Expressway

e Number of Thru Lanes <=3

* Excluding Interstate and
Freeway and Expressway
road functions you are left
with almost 7100 miles of
roadway segments that will
be evaluated.

Rural Horizontal Urban Mo
Mumber of Thru Curves Miles Horizontal Mo Horizontal Horizont
FFC Lanes (mi) Curves Miles Curves Rural (mi) al Curves
Local <=3 39.742 10.74 12625.262| 1787.009
Interstate <=3 676.49 163.126 9.943 3.099
Other Freeway or
Expressway <=3 17.07 30.121 0.02 1.39
Other Principal
Arterial <=3 784,128 116.044 7.644 15.728
Minor Arterial <=3 946,234 214.996 0.988 16.823
Major Collector <=3 3252.311 446.426 45.255 14.727
Minor Collector <=3 2065.583 111.718 10.928 1.66
JT781.558 1093.171 12706.04 1840.436
Mo
Urban Horizont
Rural Horizontal Horizontal al Curves
Number of Thru Curves Miles Curves Miles Mo Horizontal Urban
FFC Lanes {mi) [mi) Curves Rural {mi) {mi)
Local <=3 39.742 10.74 12625.262| 1787.009
Other Principal <=3 784128 116.044 7.644 15.728
Minor Arterial <=3 946.234 214.996 6.988 16.823
Major Collector <=3 3252311 446.426 45,255 14.727
Minor Collector <=3 2065.583 111.718 10.928 1.66
JOBY.998 899.924 12696.077 1835.947




Crash Modification Factors (CMF’s) used

e Centerline Rumblestrips

e Lane Width

e Shoulder Width and Type * Passing Lanes
* Horizontal Curves  Two Way Left Turn Lane
e Super Elevation * Roadside Design
* Grades * Lighting
* Driveway Density
Worksheet 1B -- Crash Modification Factors for Rural Two-Lane Two-Way Roadway Segments
r 0 (2) (3) _4) (5) (6) (7) (8) (3) (10) (11) (12 T (13
CMF for Lane CMF for CMF for  |CMF for Supery CMF for CMF for | CMF for | CMF for | CMF for CMF for CMF for CMF for | Combine
Width Shoulder Width| Honzontal elevation Grades Driveway | Centerlin | Passing | Two-Way | Roadside Lighting | Automated | d CMF
and Type Curves Density |e Rumble| Lanes | Lefi-Tumn Design Speed
Strips Lane Enforcemen
CMF 1r CMF 2r CMF 3r CMF dr CMR 5r CMF6r | CMF7r | CMF 8r | CMF 9 | CMF 10r CMF 11r CMF 12r CMF comb
from Equation | from Equation from from from Table from from from from from from from (1)x(2)x
10-11 10-12 Equation 10- | Equations 10-| 10-11 Equation 10- | Section | Section | Equation |Equation 10- | Equation 10- | Section
13 14, 10415, or 17 1071 | 1071 |10-18 &10 20 21 1071 |[x(11)x(12
10-16 19 )
1.02 1.02 1.14 1.00 1.16 1.31 0.94 1.00 1.00 1.07 1.00 1.00 1.814




Data Inputs

Horizontal and Vertical Curve Data
* ARAN Database
* Horizontal Curve Data includes Radius, Length, Superelevation
e Vertical Curve Data includes Start and End Slopes

Centerline Rumblestrips
* Managed in the Linear Referencing System (LRS)

Cross Sectional Data
* Managed in the LRS

* Lane and Shoulder Types and Widths
e Passing Lanes and Truck Lanes

* Guardrail data managed in Maintenance System

Factored AADT's

 AADT’s managed in the LRS and factors are used to factor this value to the current year.

Observed Crash Crashes
* All crashes are reviewed and kept in sync with the LRS
* Expected Results would be compiled based on 3,5, and 10 years of observed crashes



GIS Segmentation

* Nightly Extract, Transform, and Load (ETL) of Road Network
Segmentation that includes items from the LRS in addition to other
items.

* 1/10 mile Pavement Data
Horizontal and vertical Curve Data Best-Of (2015-2021 Data Collections)
Standard LRS Assets used for Reporting (FFC, Street Name, AADT, etc.)

Calculated Project Items such as Most Recent Highway Treatment, Full Project
History.
Current segmentation includes 450,431 segments



Horizontal
Curve Data

e Based on report from
software used with
ARAN.

* Includes Radius, Length,
Super Elevation

 Many Routes do include
curve data collected for
both directions, but
HSM segment output set
to one side.

* Three Types of Curves

= SEG_LEN TYFE

3 6632.621 Line
2190.892 | Arc right
2129.329|Arc left

MlElrlc-lalF

MolF ]

Feature Cache =

ArcAngle: 23.04

Radius: 2954 05
Degree: 1.94
Length: 1189.96

ey o [ P |
= VISION_CLURVE_HORIZ_ID
£ 26256
&
Location: 502,068,192 4,911,821.883 Meters | ;
Field Value 2
objectid 534672
Curve Type Arc right
Radius 2954.05
shape Palyline M
Degree of Curve 1,939565
Arc Angle 23.03553
Length 1189,956309
Number of Samples 1139
Pavement Class A
Elevation at Start 64, 264657
Elevation at End 61706168
Heading Dir Start 309.919358
Heading Dir End 332.956412
Curve Types znull>
Route HO530
Begin RLM 20,036
End RLM 20,262
Start Superelevation 1.95715
Middle Superelevation  2.85743
End Superelevation 2.418237
Average Superelevation 2.977183
Maximum Superelevation 3.953123
Angle Paint -0.691408
ROW Image at Start http: {jmdotinetappssty. state me,usYVision_VideoWetwork20 18 \ROW\196P0Q 2040010000 20000218\000020 104165, §
ROW Image at End http: /mdotinetappssty. state.me.usYVision_Video\Network 20 19RO\ 196P0Q 204000000 200002181000020332106.t §
My ID 26256
CURVE_YEAR 2019
CONSTRUCTION_FLAG  <null= v




Vertical Curve Data
e Used the absolute max of the Start and End Slope

* Multiple Horizontal Tangents were combined and
then segmented based on Vertical Curve Changes

TYPE
9:5ag

SEG_LEN
4129.24

4012.729|Crest
1433.968 | Line up
1380.952|Line down

25

Feature Cache _

Identify from: |

Labeling -
28723

Vertical Curves
% [ VISION_CURVE_VERT_ID
VISION_CURVE_VERT_Label
# [ VISION_CURVE_VERT_1
# [ VISION_CURVE_VERT_ 2
VISION_CURVE_VERT_3
Line Type
Crest
Sag
== Line up
== Line down
[ Vertical Curves Enriched
[0 Horizontal Curves
[ Horizontal Curves Enriched
mdot/MaineDOT_Tiled

o

& =}

RO@ kil &= |-

pf Contents a1 x
[e¥ AN

Layers

Type: Crest
Ai-4.64

K: 9253
Length: 429.84
G1:-1.34

G2: 5.977

Type: Line down
Length: 676.41
Grade: -6.22

Type: Sag

A 052

K: 1416.61
Length: 735.78
G1:-1.08

G2: -0.565

Type: Crest
A:-6.05
K:130.14
Length: 787.20
G1:4.97

«<Top-most layer>
=I- VISION_CURVE_VERT_ID

A

Location:

| 502,003.575 4,911,892.464 Meters

Field

objectid

Line Type

Slope at Start
Slope at End

A

K

shape

Length

Mumber of Samples
Pavement Class
Elevation at Start
Elevation at End
Routs

Begin RLM

End RLM

ROW Image at Start
ROW Image at End
My ID
CURVE_YEAR
CONSTRUCTION_FLAG
SHAPE.LEN

Value

301264
Sag
-1.084824
-0.56474
0.520084
1416.611153
Folyline M
736.783636
708

<null>
54.241984
62.390751
HO530

20.1

20.24

http://mdotinetappsstg. state. me. usiVision_Video Metwork2019\R.OWY 196P0Q 204001000020000218Y000020168154.jpg
http://mdotinetappsstg. state. me. us'jVision_Video \Network2018\ROW\ 196P0Q2040010000200002 184000020 308085, jpg

28723

2019

<null=
224,507522

Identified 1 feature




Driveway Density

e Associate e911 geocoded
address points to DOT Road
Centerlines

* DOT Road Centerlines broken
up into ~1 mile segments
based on the Primary Route.

* This was completed using an
Oracle View and functions and
methods available in the
Database to Dissolve
segmentation and to create
segments of any length.

V_PRIMARYROUTESOMEMILE: Created: 12/14/2021 12:10:18 PM LastDDL: 12142021 12:31:25 PM  Status: Valid
Columns Script Data

- -EE

Grants Synonyms

< =l

Deps (Uses)

Deps (Used by)

w

Triggers

oS -3 &

Constraints  Errors

Auditing

1649
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00o01X
0001X
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00o01X
0001X
0001
00o1x
00o01x
0001
0001
00o01X
0001X
0001
0001X
00o01x
0001
0001
0001
0001X
0001X
0001
00o1x
00o01x
0001
0001
00o01X

a
1
1.57
2.57

7.57

10.57
11.57
12.57
13.57
14.57
15.57
16.57
17.57
18.57
19.57
20.57
21.57
22.57
23.57
24.57
25.57
26.57
27.57
28.57
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Driveway Density

Original E911 Address Point Locations

Snapped Geocoded Points
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Driveway Density
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How Dataset was Put Together

* Logic was adapted using HSM Part C and

. . My _HSIS_SEGMENTS_SETUR H
Excel File for Rural Two Lane Roadways in MV_HSIS_SEGMENTS SETUP DS g
MY_HSM_CRASH_RATE_LU
Ore gon MV_HSM_CRASH_SEGMENT YR_PIVOTS
https://www.oregon.gov/ODOT/Engineering/ Spibyiiio bl -
Docs TrafficEng/HSM-OR Rural-Two-lane.xls MV_HSM_SEGMENTS_CMF
MV_HSM_SEGMEMTS_FOR_MAFPING
. . MV_HSM_SEG_CALCULATIONS
* Logic and formulas were adapted for use in MV HSM_SEG ROLLLR
Structured Query Language (SQL) in and
Oracle Database
* Based on a series of views in the GIS
Database that help pull together different
objects.
My_HSM_CRASH_SEGMEMT YR_PIVOTS: Created: 3/15/2022 11:08:35 AM Last DDL: 6/21/2022 9:28:38 AM Mat., View

Primary Key: <MNone:

Desc
[ Auto Refresh

Columns Indexes Constraints Triggers Datd  Seript  Partioning Grants Synonyms Stats/Size  Referential  Used By  Auditing
4 | | Sortby PK

T "qi!. 'E%' = DReadOnly

4P pPd=avxed-F

=|PD_TOTAL IN]_TOTAL KEYFIELD |CRASH_GROUF NUMYEARS_CRASH_GROUP| CRASH_COUNT AADT_FACT AVMT

» 22 7|3966588-2|5 Year 3 29 3810/4151090.25
17 4/3966588-2|3 Year 3 21 3810/4151090.25
37 11/3966588-2|10 Year 10 48 3810/4151090.25

CRASH_RATE| SEGMENT_LENGTH|HZ_GENERAL_TYPE|K_IN]_CRASHES|A_IN]_CRASHES B_IN]_CRAS|Z]

139.72233 2.985 | Tangent 0 0
168.630398 2.985 | Tangent 0 0
115.632273 2.985 | Tangent 0 0



https://www.oregon.gov/ODOT/Engineering/Docs_TrafficEng/HSM-OR_Rural-Two-lane.xls

Database Objects

View
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HSM Specific Objects

AASHTO_4_PERCENT RURAL
ry y
'8 k1
P X ';-l MV_HORIZ_CURVES_ROADWAY ROLLUP H MV_HZ_CURVES SUPER_DEV ?_
p IR - - - - [
T““ T L % My HSM_CRASH SEGMENT YR PIVOTS }
_rf'\- . [/ L l
AASHTO_6_PERCENT RURAL !
sl | MV_ESM_CRASH RATE LU
B N S e :
V_SEGMETRANS MASTER_LOOKUP
4 y Y
) m_HSM_SEG_EnLCumntM'
V¥V Y ¥ rL J
) 1
MV_HSIS_SEGMENTS_SETUP DS 4% MV_HSIS_SEGMENTS SETUP ii
A A Y .
] ¥
[
MV_HSM_SEGMENTS_FOR_MAPPING
L
Yy .
MV_HSM_SEGMENTS CMF }7
}I MY _HSM_SEG_ROLLUP |




Crash Modification Factor Ranges

* The following are the range of the Crash Modification Factors (CMF) values for the 12
used on Two Way Rural Roadways.

= CMF_DESC MINVAL MAXVAL AVGVAL
b Lane Width 1) 1.225 1.055
Shoulder Width and Type 0.942| 1.225  1.05
Horizontal Curves 1) 28.32) 1.787
Superelevation 1) 1.629 1.016
Grades 1 1.16) 1.079
Driveway Density 1| 4.163 1.382
Centerline Rumblestrips 0.94 1| 0.996
Fassing Lanes 0.63 1| 0.997
Two Way Left Turning Lane 0.663 1| 0.999
Roadside Design 0.875 1.222| 1.068
Lighting 0.931 1 0.986

Automated Speed Enforcement 1 1 1



Deliverables

* Predicted/Expected/Observed Results are part of a materialized view
in the Database that is refreshed daily based on any changes in the
segmentation and/or calculations.

* Segments can be mapped using Route/Measures

* Mapped dataset includes a Feature Layer with 252 columns

https://maine.maps.arcgis.com/home/item.html?id=afc08ad8680e4ccd4ad32a3414e0b5482&view=table&so
rtOrder=desc&sortField=defaultFSOrder#data

[] HsSM_Rural_Ssgments_10_Years Bl Feature Layer (hosted, view) o + T ewe Mar 16, 2022
[[] HsM_Rural_Segments_5_Year @  Feature Layer (hosted, view) - o+ e eee Mar 16, 2022
] HSM_Rural_Segments_3_“Year @ Feature Layer (hosted, view) - -+ e e Mar 16, 2022
[] HS5M Rural Segments E service Definition i e e Mar 15, 2022

e ~95,000+ segments for the 7100 miles for each of the observed year
groupings

* A subset of the segments can easily be created and provided for use in
Safety Benefit type calculations.


https://maine.maps.arcgis.com/home/item.html?id=afc08ad8680e4cc4ad32a3414e0b5482&view=table&sortOrder=desc&sortField=defaultFSOrder#data

ArcGIS Online Dashboard

* Example that links to other ArcGIS Online (AGOL) Applications.
https://maine.maps.arcgis.com/apps/dashboards/5b9f3641464f48909dd864e
2c6adOcea

Filter by Route in Map Excess Crashes Per Year Filter By Town in Map - _
HSM Rural Segments Example o e Observed Crashvearts) [ 3 | = ||l | =
Segments By Expected Vs Predicted Cost = - Crash Injury Level Distribution
@ .
Bethel (10 Years) ""f/,( .
0002X,13.301-13.482 . A o 2)
Excess Crash Rank: 60 ~ % PD 17
Par Year Total T—'
) B4
Excess Crazh 0,68 .77 <@ 3 = z -
Fradicted Crazh 0.35 254 r "' %
Obzervad 2500 bs %
Crash ) Bethel Rgnl = ce
Expscted Cost 5148,941.62  [51,489,41619 + >
Eradictad Cost 551,022.00 £510,819.97 e Crash Types
'] Exp v= Pred Diff 507.859.62 5972,596.23 E
Crash Dashboard a Lane Departure 3
HSM Historic Dashboard (3,5,10 Years) "—:;'., Rear End T
Map Viewer Link = o !
ap Viewer Li N 2 Bike/P=d |0
Download Segment Data P o Intersection | 10
Movemsant
Morth Rg . Animal - 1
AR Mayville
Crher ICI
_'_ ] 5 10 15
)
o %, — # of Crashes
0 : s
T Map ‘ ‘ Esri, N y Map= Contributors, Esri, HE jarmin, SafeGraph, GeoTechnologies nc ME... Powersd by Esri —‘ 1 Injury Level and Crash Types ’ r
Seg Type Route Code BMP EMP  Seg length Excess PerYear Exp CostPerYear Exp 10Year Worth Exp Crash Per Year Exp F&| PerYear Exp PD PerYear Pred CostPerYear Exp vsPred Cost PerYear Exp Total Costs Pred Total Cost Obs Crashes Obs F&l Crashes Obs PD Crash
Curve QOO2K 13301 13.482 0181 0.677 $148,241.62 %1,096,223.28 1.031 0323 0708 £351,082.00 £ 97.859.62 $1,489.4156.19 | $510,819.97 23 8 17



https://maine.maps.arcgis.com/apps/dashboards/5b9f3641464f48909dd864e2c6ad0cea

ArcGIS Online Dashboard

* Explore Observed Crash Data Associated to segment.

* List Results include a link that will open to a universal crash dashboard filtered
on just the crashes for that segment.
https://maine.maps.arcgis.com/apps/dashboards/3b0042670e8c49268383d62ee4f9d0cd#feleme

ntid=3121941&eleoffset=0.431,0.612&crashyear=2012,2021&casloctype=ELEMENT

HSM Rural Segments Example

Filter by Route in Map

No category

Excess Crashes Per Year

09+
0.2

Filter By Town in Map

Observed Crash Year(s)

Z
Segments By Expected Vs Predicted Cost %, Crash Injury Level Distribution
) §
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0002X,13.301-13.462 ) " A !
Excess Crash Rank: 60 <4 i 21
o tear Toal v H .
cess Crsh 0 77 E y -
035 54 %
2500 5 ’ -
Bathol Rgn! 4
SusIE 141610 4 »
3
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I SOTAN  §9r8596 ?ﬂ
o
o Lane Degarure | s
3
3
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North iy Mapille
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0
S
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103 0323
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5

8
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13482 0181 li

17

s Crash Dashboard
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https://maine.maps.arcgis.com/apps/dashboards/3b0042670e8c49a68383d62ee4f9d0cd#elementid=3121941&eleoffset=0.431,0.612&crashyear=2012,2021&casloctype=ELEMENT

Future Goals

e Continue to evaluate what items are helpful and those that are not.
* Where is the data coming from for a calculation and if there is an issue how to
fix it?
* Relate additional crash items that are available at the Unit and Person
level

e Sequence of Events, Pre-Crash, Most Damaged Area of Unit, etc.

* Continue to explore functionality available in ArcGIS Online

* What objects are reusable for analysis that could be integrated easily with the
HSM Data

* Improve Performance of AGOL applications and Feature Layers?

* Expand Datasets available in ArcGIS Online

* Maine DOT specific datasets are pretty limited, but should really include at
the very least the layers available in the Maine DOT Public Map Viewer.
https://www.maine.gov/mdot/mapviewer/



https://www.maine.gov/mdot/mapviewer/

Future Goals

» Use statewide Digital Elevation Model that includes different lidar collections
over the past 10 years to Derive and estimated Side Slope (1:2, 1:3, 1:4).
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Contact Info

Jon Prendergast
Maine DOT Office of Safety
Jon.J.Prendergast@maine.gov
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